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COPYRIGHT

The copyright for this manual belongs to CT Systems, The Netherlands. Nothing from this manual may 
be copied or published without written permission from CT Systems.

The purpose of this manual is to give the users of the Viking software information on the use of this 
software.

This manual may not be considered as a document with which CT Systems could have any 
responsibility, legal liability or contractual obligations.
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WARNING

An experienced and careful navigator would never trust on just one expedient when determining his 
position, because the accuracy of the position, which is plotted on the chart, depends on the navigation
device.

The Viking software is a precision instrument, which is linked to a receiver. When there are interferences 
in the radio signals, the position on the chart may not match with the real position. With the CT Systems
software you can make corrections regarding position, if there is a point from which the coordinates are 
known.
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Chapter 1: Introduction

1.1 About This Manual

This manual is intended as a documented guide for installation, set up and use of the RDPS. Using the 
alphabetical index features and settings can easily be looked up.

We recommend reading this manual fully in order to get acquainted with the workings of the RDPS.

The RDPS, RDI, GeoGNSS, GeoGNSS RDPS, and the Viking Software are all products of CT SYSTEMS
BV from The Netherlands.

1.2 About RDPS

The Rapidly Deployable Positioning System (RDPS) is designed and built to be a portable and complete
system for precise positioning operations. With all components fitted in a rugged and portable Peli 
Case, showing up on a vessel with only the RDPS will assure you of exact positioning of any vessel.

The RDPS comes with highly accurate DGNSS, GNSS compass, AIS, UHF telemetry, industrial Wi-Fi, 
rugged notebook, Viking positioning software and all required adapters, cables and antennas. All in one 
box!

The philosophy behind the RDPS is that it should be portable, easy to deploy, and easy to use. The 
concept is that the hart of the system, the GeoGNSS RDPS, is to be installed outside, eliminating the 
need for long antenna cables.

An additional benefit of having the GeoGNSS RDPS located outside is that no cables need to be routed
to the bridge or control room. All communications can go through long rang Wi-Fi, or if needed by a 
single and widely available RJ45 ethernet cable.

Simply position the GNSS, Wi-Fi, AIS and optional UHF antennas outside, connect all to the GeoGNSS 
RDPS. Then the notebook running Viking will connect to the Wi-Fi antenna directly and gather all data. 
The GeoGNSS RDPS has a wide input DC power supply enabling many options for power sourcing.

1.3 Telemetry Data

Always ensure you have followed local regulations concerning wireless transmissions! Where applicable
unsure you have the appropriate license(s). 
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1.4 Physical Connections
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Chapter 2: What’s In The Box

2.1 System Contents

The RDPS is built up out of the follow components:

Quantity Product

1 Peli Case 1610 with foam inserts

1 Dell Rugged Latitude + Power Adapter

1 Viking Offshore Software (USB Dongle)

1 GeoGNSS RDPS (Peli Case 1200)

1 Wi-Fi Bullet

2 Trimble LV59 GNSS Antenna

1 Procom UHF Antenna

1 Procom Wi-Fi Antenna

1 AIS Antenna + Magnet Mount

2 Marine Antenna Bracket LV59

2 Procom Antenna Bracket

2 RG223 GNSS Coax Cable, 5 metre, TNC/TNC

1 RG223 UHF Coax Cable, 5 metre, TNC/N

1 RG58 AIS Coax Cable, 5 metre, BNC/FME

1 CT-Lemo PoE Cable Lemo 8p, 5 metre

1 CT-Lemo Serial RS232 Cable (only for SHM model)

1 CT-Lemo Power Cable  + Adapter

1 Ethernet Cable RJ45 1.5 metre

2.2 Security Hardware Key

The Viking software package is protected by a HASP USB security key. In order to run Viking a HASP 
key supplied by CT Systems needs to be inserted into a functioning USB port of the computer. 

The HASP key will also contain digital keys for various special functions in the Viking software.

WARNING

In case of a loss of the HASP key the replacement of this
key requires a full re-purchase of the licensed software!
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2.3 System Components Packaging
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Chapter 3: Mobilisation

3.1 Setting Up The RDPS

• Find a suitable and fixed spot where both GNSS antennas have a good and uninterrupted view 
of the full horizon, placing both GNSS antennas as far apart as possible. Connect both using the
TNC/TNC RG223 cables to the GeoGNSS RDPS.

• Connect the Wi-Fi Bullet to the Wi-Fi Procom antenna (make sure not to use the UHF Procom), 
and connect the CT-Lemo 8 pin PoE cable to the underside of the Bullet. Recommended to 
wrap the underside of the Bullet and part where the Bullet meets the Procom with vulcanising 
tape.

• Place the AIS antenna with the magnetic mount on a metal surface and connect to the 
GeoGNSS RDPS using the BNC/FME RG58 cable.

• If needed connect the UHF Procom to the GeoGNSS RDPS with the TNC/N RG223 cable.

• Make sure all antennas are upright and have as little obstructions around them as is possible. 
Recommended to keep line of sight between the targets/receivers of the antennas (i.e. between 
Wi-Fi Bullet and notebook).

• Power up the GeoGNSS RDPS using a 9~30 VDC continues power source.

• Install the notebook on the required location and connect it to the RDPS Wi-Fi network, and 
power up the Viking software.

3.2 Configuring Viking

Assuming Viking is still configured correctly and has all equipment already configured, and connected in
the Equipment Manager the following steps are necessary for every new mobilisation:

• Set Viking to the Chart Datum and Projection used in your project with Settings  Coordinate →
System  Change→  and selecting the appropriate system. The active system is always shown in 
the bottom right of the Viking Screen.

• Using Settings  Ship  Ship Layout→ →  and by pressing Create a new vessel layout can be either 
drawn directly in Viking, or be imported from a DXF (in metres, front pointing to the right, close 
to local coordinates 0,0).

• Once the layout is imported or drawn the most important step is to enter the exact Fix Points for
the GNSS antennas. Near the bottom left of the Ship Layout Editor click on the Fix Points tab 
and click on Create Point to create a new Fix Point in the drawing. Using the mouse you can 
place it on the exact location of each antenna, optionally using the X, Y & Z coordinates in the 
table below they can be fine tuned. Recommended to rename the Fix Points to the names of 
each GNSS antenna.
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• Save the vessel layout with a unique name and make sure that name is selected on the left 
before pressing OK.

• Go to Settings  Equipment Manager→  and make sure that the Fix Point for the GPS is the fix 
point of the primary antenna. This can be changed by clicking on GPS and clicking Setup, then 
choose Change Position and select the correct fix point. Also check under Advanced in the GPS
setup window that the correct Chart Datums are selected for each type of GPS fix.

• Where needed a heading offset can be given using Settings  Equipment Manager  Heading → →
 Advanced.→

Optional But Recommended:

• Create a dynamic object of the exact GNSS antenna location using Managers  Object →
Manager  Create → Object  (type) Viking  → → Ok. Give the object a name and in the sizes field 
enter a number of radiuses (metres) for circles, each radius on a new line (for example 0.05, 
0.25, 0.5) and press Ok.

• Select the newly created object from the list and press Place Object. Heading should be set to 
Heading Fixed, and under Source select the GPS receiver from the list and press Ok. Now the 
circle should be visible on the nav screen on the exact location of the GNSS antenna.

3.3 Position Check

Recommended Procedure

With the system now up and running a position check is highly recommended. Highly recommend is to 
do a position check using a stand alone and highly accurate GNSS, by comparing the output 
coordinates of the stand alone GNSS on various locations on the vessel with the coordinates that Viking
calculates of those specific points.

Alternative

An alternative is to use the GeoGNSS RDPS itself for a position check. This alternative is not 
recommended and should only be used if no other means are available and common sense should be 
applied.

• Set up the dynamic object as described as optional here above.

• Make 100% sure the vessel is not moving!

• Draw an accurate outline around your vessel and mark points of the vessel which you want to 
check by selecting File  Chart  Create New → → then in the newly opened Left Hand Side Bar 
and using the built in Chart Editor. When finished save the outline as a Viking Chart.

• Go to Settings  View  General  Ship→ → →  and set the line width to 0 (zero). Now Viking will no 
longer draw your vessels layout, but instead you should only see the dynamic object and the 
layout that you drew as a Viking Chart.

• Place the primary GNSS antenna (ignore the secondary for now) on strategical points on your 
vessel to check if they match up with the drawn overlay.
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• Set the line width of the vessel back to 1 or higher (Settings  View  General  Ship)→ → → . The 
chart can be removed from the Right Hand Sidebar (F10 - Files).
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Chapter 4: Defaults & Software Installation

4.1 Default RDPS Settings

RDPS SHM RDPS WZN

IP Address Wi-Fi Bullet 192.168.1.20 192.168.1.20

IP Address Wi-Fi notebook 192.168.1.101 192.168.1.101

IP Address Ethernet notebook 192.168.1.102 192.168.1.102

IP Address & Port Number GNSS Direct 192.168.1.121:5017 192.168.1.121:5017 GGA, GST, HDT

IP Address & Port Number GNSS GeoGNSS 192.168.1.141:5017 192.168.1.141:5017 Channel #1:
5017, 115200

IP Address & Port Number UHF GeoGNSS 192.168.1.141:5017
(read only)

192.168.1.141:5018 Channel #2:
5018, 19200

IP Address & Port Number AIS GeoGNSS 192.168.1.141:5017 192.168.1.141:5019 Channel #3:
5019, 38400

Wi-Fi Bullet Network Name CT-RDPS CT-RDPS

Wi-Fi Bullet Network Password 1122448811 1122448811

4.2 New Viking Installation

In the event that a new PC is used or all settings are lost below is an overview of installing and setting 
up a new Viking software installation.

Installing New Viking

• Install newest Viking Setup FULL, followed by LATEST (if applicable)

• Run Viking and go to Settings  Equipment Manager→

• Click Add  GPS  NMEA and Add, repeat this for:→ →

◦ Heading  NMEA→

◦ AIS Receiver  NMEA→

◦ Output  Viking→

Setting Ship Control

• Settings  Ship  Ship Control, and select:→ →
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◦ Differential

◦ No Height

◦ No Draft

◦ GPS Device: GPS NMEA

◦ Heading Device: Heading NMEA

◦ No Motion

• In the backup tab you could for example have the same as above but for GPS set to Normal. In 
backup mode there is no logging or DTM update, just a position and a big warning on the 
screen

Configuring Equipment

• GPS NMEA:

◦ Settings  Equipment Manager  Click on GPS NMEA  Click Setup (or double click on → → →
GPS NMEA)

◦ Click Change Connection and select the appropriate COM, TCP or UDP and configure (use 
the Add button in bottom left to add TCP/UDP)

◦ Using Calibrate set the correct Datum for each GNSS fix mode (important)

◦ Select the appropriate Fix Point under Change Position (important)

• Heading NMEA

◦ Settings  Equipment  Heading NMEA→ →

◦ Configure connection and optionally set a heading offset in Advanced

• Output Viking

◦ Settings  Equipment  Output Viking→ →

◦ Configure connection

After installing a new Viking installation follow the instructions in the Mobilisation chapter above.

4.3 UHF Configuration

To configure the internal Satel modem the “Satel Configuration Manager” software is needed. It can be 
downloaded from the Satel website for free. More details on how to configure and program the satel 
can be found in the Satel user manual.
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Important to note is that the baud rate (19200) of the internal satel should not be changed, and should 
match the internal channel number.

SHM Model

The SHM model is limited to being able only to read from the UHF data over TCP. For full two way 
access, or to program the Satel the CT-Lemo Serial cable is needed, and needs to be plugged directly 
into the RDPS on the left side.

WZN Model

The WZN model has full read/write access to the Satel over TCP. This does however mean that for 
programming the Satel an extra step is needed as the Satel software is limited to only accessing 
Comports directly.

Using the VSPE software
(available for free) a virtual
comport can be created.
This virtual comport can
be connected to a TCP
client to the port of the
UHF in the RDPS.

In the Satel configuration
software this comport can
then be selected for direct
programming.

Please note that the when
configuring and starting
VSPE Viking and all other
software using the TCP
connections of the RDPS
should be closed!
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Chapter 5: Remote Data Interface

5.1 About

The Remote Data Interface (RDI) is an optional extension to the RDPS. The RDI also consists of a Peli 
1200 with an internal industrial device server and coupled with industrial Wi-Fi. The RDI enables remote 
and direct access to additional sensors and positioning equipment.

5.2 System Contents

The RDI System is built up out of the follow components:

Product Quantity

• Peli Case 1610 with foam inserts 1

• Dell Rugged Latitude + Power Adapter optional 1

• Viking Offshore Software (USB Dongle) optional 1

• RDI (Peli Case 1200) 1

• Wi-Fi Bullet 1

• Procom UHF Antenna optional 1

• Procom Wi-Fi Antenna 1

• Procom Antenna Bracket optional 1

• RG223 UHF Coax Cable, 5 metre, BNC/N optional 1

• CT-Lemo PoE Cable Lemo 8p, 5 metre 1

• CT-Lemo Serial RS232 Cable 2

• CT-Lemo Power Cable  + Adapter 1

• Ethernet Cable RJ45 1.5 metre 1

5.3 Default RDI Settings

RDI

IP Address Wi-Fi Bullet 192.168.1.21

IP Address Wi-Fi notebook 192.168.1.103

IP Address Ethernet notebook 192.168.1.104

IP Address Device Server configuration local webinterface 192.168.1.142

Default Baud Rate (all comports) 115200

IP Address & Port Number Port 1 192.168.1.142:5300

IP Address & Port Number Port 2 192.168.1.142:5301
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IP Address & Port Number Port 3 192.168.1.142:5302

IP Address & Port Number Port 4 192.168.1.142:5303

Wi-Fi Bullet Network Name n/a, connects to CT-RDPS

Wi-Fi Bullet Network Password 1122448811
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5.4 Schematic System Overview

www.ctsystems.eu Page 20 

(optional)

RDI Unit

PoE WiFi

UHF

GeoGNSS RDPS System

Wireless
connection

to RDPS

IOIOIOIOIO
IOIOIOIOIO

IOIOIOIOIO
IOIOIOIOIO

External RS232 Sources

2nd Viking System



RDPS Version 1.1 Chapter 5: Remote Data Interface

5.5 Configuration Examples

Robotic Total Stations

The RDI can be used to collect data from two robotic Total Stations enabling Viking to do relative 
positioning using the first total station for positioning and the second for heading reference.

• Install the robotic total station on the static reference object and install the reflectors on the 
dynamic object

• Make sure both total stations are working in the same XYZ local world (important)

• Make sure the external data sources are set to 115200 8N1 (otherwise use the local web 
interface of the device server in the RDI to edit the RDI settings itself)

• Connect the external data sources to the two Lemo Comports of the RDI

• Power up the RDI, it should automatically connect to the Wi-Fi of the RDPS

• Configure the Viking System on the RDPS system as follows:

◦ Go to Settings  Ship  Ship Layout  Fix Points → → → add the exact locations of the reflectors 
to the ship layout, name the first one POS and the second HDT

◦ Add and configure the following equipment to the Viking Configuration:

▪ Settings  Equipment Manager  Add  GPS  Custom XYZ→ → → → , rename to POS

▪ Repeat above for second Custom XYZ and rename to HDT

▪ Configure the primary total stations data connection to the POS Custom XYZ, and set 
the position of the POS Custom XYZ’s Fix Point to the POS Fix Point

▪ Press Advanced and configure the parsers for X, Y & Z inputs from the total station

▪ Repeat above for the HDT Custom XYZ and set to the secondary total station

◦ Go to Settings  Ship  Ship Control → → and set the GPS device to POS Custom XYZ and the 
Heading Mode to Secondary GPS and the Heading device to HDT Custom XYZ

• All should be set and Viking should now be using the robotic total stations for positioning and 
heading. Highly recommended to do a verification of correct positions and heading using a 
stand alone method!
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Chapter 6: Troubleshooting

6.1 Troubleshooting

HASP Key Not Recognized 

Please check the following:

− Check if the USB port is functioning
− If used, check USB Cables and USB Hub
− Execute 'HASP Reinstall' program located in Viking's sub directory in the Windows Start Menu

The Position Of The Ship Is Not Visible, Whilst A GPS Is Active

By pressing the Follow Ship icon or the Follow Ship option in the View Menu the Ships position will be 
kept on screen.

The GPS Status Icon Is Red Or Yellow

Probably the minimum GNSS status is selected too high for the current GNSS used. 

No Windows Controls Such As The Task Bar Are Visible

Viking is likely in full screen mode, this can be toggled using the F11 key or from the Full Screen option 
in the View Menu.

The Entire Display Seems Fully Black Or Very Hard To Read

It could be that Viking is still in night mode, by using the key combo CTRL + N it will switch back to the 
normal colour scheme.
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Chapter 7: Glossary Of Terms

AIS - Automatic Identification System

COG - Course Over Ground of a moving object

DXF - Drawing eXchange Format, is a CAD file format developed by Autodesk. It is 
used for interchanging vectorized drawings between software products.

GLONASS - GLObal Navigation Satellite System, the Russian navigational satellite network.

GNSS - Global Navigation Satellite System. Used to refer to any sort of Satellite 
navigation. Including GPS, GLONASS and Galileo.

GPS - Global Positioning System. Used as a general term, but officially refers to the 
Navstar network of the United States of America's government.

HDG - Abbreviation for Heading of a moving object

PoE - Power over Ethernet

RS232 - In telecommunications, RS-232 (Recommended Standard 232) is a standard 
for serial binary data signals connecting between a DTE (Data Terminal 
Equipment) and a DCE (Data Circuit-terminating Equipment). It is commonly 
used in computer serial ports

SOG - Speed Over Ground of a moving object

TCP/IP - Transmission Control Protocol / Internet Protocol. The Internet Protocol Suite is
the set of communications protocols used for the Internet and local networks.

USB - Universal Serial Bus, a hardware standard used all over the IT industry. Used 
for connecting all sorts of peripherals. A five volt power is also incorporated 
into the USB interface.

UHF - Ultra High Frequency wireless long range telemetry system

VCT - Viking Chart file format. Used by Viking to store it's vectorized chart in binary 
form.

VMA - Viking Matrix file format. Used by Viking to store 3D DTM matrix data.

VTK - Viking Track file format. Used to store the tracked locations of the vessel in a 
binary file format.
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Chapter 8: User Manual Revision History

Version 1.0 08 April 
2020

Initial release after merging and evolving from previous products; 
Portable TMS and Rapid Response System

Version 1.1 06 
September 
2022

Modified TCP setting of WZN model, added channel detail.
UHF Serial only for SHM model notes.
Added notes for WZN UHF config method.
Added Viking networking output config.
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